Image Map Project
1. Create a Dreamweaver folder on your desktop and title it the name of your webpage
2. Next create two folders inside your folder. Name one folder Design files and one Web files
3. All of your files must be in this Dreamweaver folder


Create the navigation buttons
1. Save the web button template file in the design files folder
2. Open the web button template.psd file
3. Change the color to a color of your choice:
a. [image: ]Click on the change color later in the layers palette
b. Select your color with the color picker
c. [image: ]Use the paint bucket tool and click on the button on canvas to replace the green color with your new color 
4. Place an image inside each button that relates to the topic page (6 total buttons)
5. Using the template, place the image later above the change color layer
6. Save each button as a PSD in the Design files folder
7. Each button will need to be merged before you can move to your web pages, so do this now
8. [image: ]Click on the down arrow/4 lines button in the upper right corner of the layers pallette
9. This will open a drop down menu of coices
10. Select Merge Visible 
11. Save each button as a new PSD in the design files folder
12. You will use the merged PSD files for your pages











[image: ]Now you will create your banners in Photoshop
1. Make a new file (Ctrl N)
2. Change width to 700, height to 100 pixels, change resolution to 72, click ok
3. You will now have a rectangle canvas
4. Design each banner (6 total) for your website
5. Each banner must include the text in a creative font choice
6. Each banner must include at least 2 images that describe that section 
7. Save each banner as a PSD and JPEG in the design files folder
[image: ]

[image: ]
Next, begin designing your pages in Photoshop 
1. Make a new file
2. Click on the preset drop down arrow, select web
3. Click on the size drop down arrow, select 1152 x 864
4. Click ok
5. Decide a color for your background and fill in, you can choose any solid color. [image: ]You can either use the same color on each page or you can change the colors for each page
6. Save your homepage as homepage.psd in design files. You will use this PSD file for creating every page for your website
7. Open your homepage banner, drag the banner onto the homepage.psd, use the move tool (V)
8. Ctrl A on the keyboard to select all, puts a selection box around everything
9. [image: ]Just below the top menus you will see a series of buttons that will allow you to center images. The buttons look like boxes with lines (to the right of the Show Transform Controls)
10. Click on the Align horizontal centers button to center the banner horizontally
11. Click on the Align top edges button to snap the banner to the very top of the canvas
12. Ctrl D on the keyboard to deselect

[image: ]Your banner should now be centered on the page horizontally and snapped to the top edge

13. [image: ]Tap the down arrow key on the keyboard ~20 times to move your banner down some from the top edge
14. Add every banner to this page and repeat the process 
a. You are going to have a lot of layers for this project so label every layer in the layers palette[image: ]
15. Add layer styles of your choice to the banner to make it stand out (drop shadow, outer glow, etc). Copy the same layer styles to each banner layer
16. Click the eyeball to turn off each banner layer that you are not using while creating a particular page
17. Open all merged button PSD files, drag all buttons onto the homepage
18. Next you will align your navigation buttons
19. Click on the home layer in the layers palette
20. Click on the Move Tool (V)
21. Ctrl A on the keyboard to make a selection of dancing ants around everything
22. Click on the Align left button under top menus (same area where you aligned the banner to the center and top). [image: ]This will snap your home button to the far left of the canvas
23. Ctrl D to deselect
24. Tap the right arrow key ~20 times to move the home button over
25. Ctrl R on the keyboard to bring up rulers
26. Click inside the ruler and drag right a guide (blue line) to snap to the left edge of the home button
27. Select all the navigation button layers in the layers palette, click on the move tool
28. Click align left edges
29. This will snap all your buttons to the same left alignment as the home button
30. Adjust the vertical spacing of your buttons so that there is equal spacing between each button (make sure they are equal)
a. Now your navigation buttons and banners are done
b. You will not make new files for each web page, you will use this homepage.psd for creating all your pages so you do not have to adjust buttons or banners anymore once this step is done


[image: ]
· Put all the text information and pictures you need on your document now.
· Ctrl S the homepage.psd to save as you complete a new task, especially after completing each page. This is the PSD file that holds every webpage and all items for each page.
· [image: ]When you have your homepage complete, you will need to save a copy as a JEPG file. It will not save your blue guide so you do not need to move it.
· File, Save as from the top menus
· Name the file homepageweb
· Save in the Web Files folder
· Change the format to JPEG, JPEG options box make quality 12, click ok
· Click the eyeball off for the layers to hide banner, text, and images for your homepage.

REPEAT THE ABOVE STEPS TO CREATE YOUR OTHER PAGES

· Make sure everything is saved properly. Quit Photoshop










1. [image: ]Open Dreamweaver
2. A Manage sites window may appear, if so skip ahead
a. If managed sites window does not appear, you will see a window palette in the bottom right corner called Files
b. Just below the word Files there will be a green folder button with drop down arrows
c. [image: ]Click on the drop down arrow on this folder and select manage sites
3. Once the Managed Sites window is open, click New
4. Site set up window will open
5. In the site name space type: yournameimagemap (no spaces)
6. In the local site folder, you will see a folder icon to the right of the line
7. Click the folder and select the Web Files folder inside your Dreamweaver folder
8. Click Save[image: ]
9. You should see all of your files at the bottom right
10. Next you want to create the HTML pages in Dreamweaver
11. Click on HTML under the create new Welcome Screen in Dreamweaver 
12. This will open an untitled page
13. From the top menus, click on View, Toolbars
14. You will need to have a checkbox by every item (style rendering, document, standard, browser navigation)
15. Click the icon that looks like a floppy disk (located under the code/split/design buttons in the upper left below the main menus)
16. This will allow you to save the HTML pages, all HTML pages will be saved in the Web Files folder
17. When the Save As window appears name the first page as home.html
18. Save in the Web files folder, click save, this file will now appear in your fIles palette window 
















1. Click the icon that looks like a piece of paper with a star in the corner (located under the code/split/design buttons in the upper left below the main menus)
2. This will allow you to create additional HTML pages for your site
3. New Document window will open, select Blank Page on the far-left column
4. Select <none> under the Layout column, click Create
5. This will create a new untitled page
6. Save this page the same way as before by clicking the icon that looks like a floppy disk 
7. Name the 2nd page the title of that page
8. Save in the web folder, and click save
9. The file should now appear in your Files palette window
10. Repeat the save and new file process to create all 6 pages for your website
11. You should now see 6 tabs located at the top of each of your pages. You can click on each of them to open that page.

[image: ]
1. Click on your home tab to begin with your first page
2. From the top menu, select Insert, Table
3. The table window opens 
a. Type 1 for Rows and 1 for Columns
b. Type 1152 for Table width
c. Type 0 for border thickness
d. Select None for Header
e. Click Ok
4. You will see a black outlined rectangle at the top of your page
5. Click inside the table rectangle to activate it
6. Click on your homepageweb.jpg file in the Files palette window to highlight it
7. [image: ]Drag the homepageweb.jpg file into the table rectangle on the webpage
8. Image Tag Accessibility Attributes window will open
9. Type the name of the page for the Alternate Text, click ok
10. You will see your homepage left justified
11. Click in the white area on the page that is located to the right of your JPEG on the page.
12. Left click, hold, and drag the mouse to the left over the image of your homepage. This will place a solid black like with little square boxes around your homepage image
13. Below your page is a menu tab called Properties 
14. Click the drop down arrow for Align and change from Default to Center
15. Your homepage should now be centered on the page. You should see white to the left and right
16. Click on the icon that looks like double floppy disks. This will save for all your pages. Do this every time you add something or make a change to your project

Repeat this process for every page…. Click on the tab for that page, make a table, and click inside the table. Drag the file into the table, center the page, save with the double floppys

Next you will select a background color that will be a fill color for the columns on the right and left of your centered pages
1. Click on your tab for homepage
2. From the top menu select Modify > Page  Properties (Ctrl J)
3. Page properties window will open, click on the background picker to select a color
4. You should see a combination of letters and numbers in the blank beside Background color.
5. Click apply to see what this color will look like as your background. You can change by selecting a different color and clicking apply till you get the one you like
a. Highlight this number and copy (Ctrl C)
6. Click ok
7. Apply this same color to each page
8. Click the tab for your second page
a. Modify > Page Properties
b. Paste (Ctrl V) to paste the number you copied from the homepage to the blank beside background color
c. Click ok
Repeat this process for all pages to get the background color on each page the same
Remember to double click the double floppy icon each time you make a change so you save all your work as you go


How to link the navigation buttons to various pages on the site
[image: ]Create image map hotspots on your buttons
1. Click the home tab to return to the homepage
2. Click on the image of your homepage
3. [image: ]The properties menu at the bottom will display a thumbnail of your page
4. Hotspot tool is below the word Map (arrow, rectangle, circle, polygon shapes)
5. Click the rectangle hotspot tool to select it
6. Left click and drag a box around the home button
7. This will place a blue square on top of your home button
8. A pop up box will appear reminding you to describe the image map, click ok
9. In the properties menu at the bottom, link your mapped button to the homepage and label the Alt text
10. Drag and drop the file name home.hmtl from Files palette at bottom right into the Link blank in the properties menu
11. 
12. [image: ]Type home button in the Alt bank in Properties Menu
13. Click the double floppys to save

[image: ]Repeat this process of creating the blue image maps on each button on the homepage. Drag and drop the html files for each page to the correct button. Double floppy disk to save all.

You do not have to create new images for each of the pages, but you do have to copy and paste the image maps.
1. [image: ]Click on the arrow below the word Map in the Properties Menu
2. Click on the home button image map to select
3. Copy (Ctrl C) to copy the home page button to image map
4. Click on the tab for the next page you want to work on to go to that page
5. Click on the page image so that you see the thumbnail in the Properties Menu at the bottom
6. Paste (Ctrl V) 

Repeat this process for all the pages to copy and paste the home button link to all your pages
Repeat this copy and paste process for all your image mapped buttons to set up the links for all your buttons on all your pages
You know that it worked if you see the blue image map on the buttons on all pages
Save all

[bookmark: _GoBack]

To preview your website:
1. Click on the home tab to return to homepage
2. Click on the globe icon 
3. Select preview in Google Chrome, this will open your website in Google Chrome so you can see how everything looks.
4. Make sure to click on all your buttons and links on all your pages to make sure things are linked correctly.
5. Save. I will grade your website at your desk.
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-Each button will need to be merged before you
can move to your web pages, so do this now
~Click on the down arrow/4 lines button in the
upper right corner of the layers pallette

~This will open a drop down menu of choices
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image4.tmp
-Next create your banners in Photoshop

-Make a new file (Command N)

-Change Width to 700 and Height to 100

~Change Resolution 72
~Click OK
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image5.tmp
-Each banner must include the text in a
creative font choice for the target audience
(Use dafont.com to get a good font)

~Each banner must include at least 2 images
that describe that section (Ex. speakers/waves/
headphones for audio)

-Save each banner as a PSD and JPEG in the
Design files folder
-Will use the JPEG files to drag to your pages
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-Next begin designing your pages in Photoshop
-Make a new file (Command N)

~Click on the Preset drop down arrow

-Select Web
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image7.tmp
~Click on the Size drop down arrow
-Select 1152 x 864
-Click OK
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image8.tmp
-Open the JPEG Digital Media banner
-Drag the banner onto the homepage.psd
-Click on Move Tool (V)

-Command A on keyboard to select all

~This puts a selection box around everything
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~Just below the top menus you will see a series of buttons that will allow you to center images
“The buttons look like boxes with lines (to the right of the Show Transform Controls)
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-Click on the Align horizontal centers button to center the banner horizontally &

-Click on the Align top edges button to snap the banner to the very top of the canvas
-Command D on the Keyboard to deselect
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-Next you will align your navigation buttons
~Click on the home layer in the layers palette
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image12.tmp
-Tap the right arrow key 20 to move home
button over

~Command R on keyboard to bring up rulers
~Click inside the ruler and drag right a guide
(blue line) to snap to the left edge of the home
button
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-Now you have all 6 pages ready to add your content (text and project examples)
~You can click on the eyeball on each banner layer to turn the layers on/off to see the pages with
each banner. If you want to change the color for each page then duplicate your background color
layer 5 times and change to 5 new colors and use the new colored backgrounds for the 5 other

pages.
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image14.tmp
-When you have your homepage complete you
will need to save a copy as a JPEG file. It will
not save your blue guide line so you do not
need to move it.

-File>Save As from the top menus

-Name the file homepageweb

-Save in the Web files folder

~Change the format to JPEG

~JPEG options box make Quality 12

~Click OK
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-Make sure you have saved everything
-Command Q to quit Photoshop.

-Open Dreamweaver

-AManage Sites window may appear if so go
to the step just below this one.

If Managed Sites window does not appear, you
will see a window palette in the bottom right
comer called Files

-Just below the word Files there will be a green
folder button with drop down arrows.
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image17.tmp
-Site Setup window will open
-In the Site Name blank type:

last name + first initial + dmwebsite

~This should be all lowercase with no spaces

-The Local Site Folder, you will see a folder icon
to the right of the line

-Click the folder and select the Web files folder
inside your Dreamweaver folder

-Click Save
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-Table window opens
~Type 1 for Rows and 1 for Columns
~Type 1152 for Table width

~Type O for Border thickness

-Select None for Header

~Click OK
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~Click on your homepageweb.jpg file in the
Files palette window to highlight it
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-Now we need to link our navigation buttons to
the various pages in the site.

~Create image map hotspots on your buttons
~Click the home tab to return to the homepage
~Click on the image of your homepage

~The Properties menu at the bottom will display
athumbnail of your page

-Hotspot tool is below the word Map

(arrow, rectangle, circle, polygon shapes)
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-Left click and drag a box around the home
button.

~This will place a blue square on top of your
home button.
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-In the Properties Menu at the bottom, link your
mapped button to the homepage and label the
Alt text





image23.tmp
Drag and drop the file name home.html from
Files palette at bottom right into the Link blank
in the Properties Menu.

-Type home button in the Alt blank in Properties
Menu

~Click double disk to save
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-You do not have to create new images for each
of the other pages, but you do have to copy and
paste the image maps.

~Click on the arrow below the word Map in the
Properties Menu

~Click on the home button image map to select
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image1.tmp
-Next create the navigation buttons
-Save the web button template in the Design
files folder

-Open the web button template.psd

~Change the color to a color of your choice:
1-Click on the change color layer in the layers.
pallette

2-Select your color with color picker

3-Use the paint bucket tool and click on the
button on canvas to replace the green color
with your new color.
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-Using the template, place the image layer
above the change color layer

Save each button as a PSD in the Design files
folder

(home.psd, graphics.psd, etc)
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